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1 Introduction 
 
Thank you for purchasing the KillerKeys software. It allows you to be more efficient and productive in 
practically any program by allowing you to quickly and easily access thousands of shortcuts. Shortcuts 
are searchable, organized into groups, and can pop-out into separate windows making them easy to find. 
Your most commonly used shortcuts can be organized into groups of favorites for fast access. You'll find 
everything you need to use KillerKeys confidently and successfully within this User Guide and on the 
Bella Corporation website, including video tutorials and the KillerKeys Knowledge Base. 

1.1 System Requirements 

 
 Windows XP or later 
 An internet connection to download and activate the software 
 Microsoft .Net Framework 3.5 or later (Included with Windows 7; or the KillerKeys installer will 

download and install the file for you if necessary.) 
 Apple iPad (if you wish to use the KillerKeys Express iPad app) 

1.2 Installation 

 
Three simple steps to set up your software 
 

1. Purchase the license options for your program from the KillerKeys store (www.KillerKeys.com).  
2. Download and install the KillerKeys software. The download will be available via a link on your 

emailed order confirmation receipt. 
3. On the activation window, enter your serial number and other requested information. The 

KillerKeys software is now activated; follow the instructions to complete the installation. 
 

(Note: For installation on computers not connected to the internet, please visit www.killerkeys.com/no-
internet for activation instructions) 

1.3 Launching the KillerKeys Program 
 

Once installed, KillerKeys will load automatically when Windows starts. You can change this later from the 
Settings window.  
 
The KillerKeys icon will appear in the System Tray and the Master Palette window will appear on-screen. 
The Settings window can be launched by right-clicking on the KillerKeys icon. 

 

 

If the KillerKeys Master Palette does not appear on-screen it may have been minimized the last 
time it was open. If the KillerKeys icon in the System Tray is left-clicked the Master Palette will 
appear on-screen. 

 

http://www.killerkeys.com/no-internet
http://www.killerkeys.com/no-internet
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1.4 Interface Overview: Master Palette 

 
 
The Master Palette contains all KillerKeys shortcut keys, which are organized into Groups, and is the 
main interface. 
   

 Status Text - Displays the number of shortcut 
keys in the Group, number of hidden keys and 
number of filtered keys. 

  Shortcut Search - Search for any shortcut in the 
active Application by description or by keystroke 
command. 

   

 Master Palette Icons:  

 Group Hide Icon - Hide entire groups of 
keys from view. 

 Filter Icon - Filter shortcuts by modifier, or 
direct keystrokes. 

  

 Favorites Icon - Create new Favorites Group. 
 

 Settings Menu Icon - Open the KillerKeys 
Settings Menu. 

   

 Edit Mode/Hide Keys – Hide and unhide 
individual shortcut keys. 

  User Profiles - Save separate group and shortcut 
settings. 

   
See the Section 2.1 section for further instruction. 
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1.5 Interface Overview: Master Palette Compact View 

 
 
The Master Palette Compact View occupies less room on your screen and allows you to keep KillerKeys 
open for quick access while working in a clean environment. 
   

 Status Text - Displays the number of shortcut 
keys in the Group, number of hidden keys and 
number of filtered keys. 

  Shortcut Search - Search for any shortcut in the 
active Application by description or by keystroke 
command. 

   

 Master Palette Icons:  

 Group Hide Icon - Hide entire groups of 
keys from view. 

 Filter Icon - Filter shortcuts by modifier, or 
direct keystrokes. 

  

 Favorites Icon - Create new Favorites Group. 
 

 Settings Menu Icon - Open the KillerKeys 
Settings Menu. 

   

 User Profiles - Save separate group and 
shortcut settings. 

  

   
See the Section 2.1 section for further instruction. 
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1.6 Interface Overview: Floating Palette 

 
 
 
A Floating Palette is useful for keeping your most commonly used shortcuts on-screen. 
   

 Movement Bar – Click and drag to move the 
Floating Palette. 

  Close Floating Palette – Click this to close the 
Floating Palette and send it back into the Master 
Palette. 

   

 Shortcut Key – Click any shortcut key to 
execute the shortcut command. 

  Resize Triangle – Click and drag to resize the 
Floating Palette. 

   
See the Section 2.1 section for further instruction. 
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1.7 Interface Overview: Settings 

 
The Settings window is where you can change the appearance of your shortcut keys. 
   

 Applications List – Displays available 
KillerKeys program settings. 

  Global Settings – Adjust KillerKeys startup and 
Hide/Show shortcut settings. 

   

 Key Settings:  
Preview Area – Previews the current shortcut 
keys configuration. 
 
Key Size – Adjust size settings. 
 
Mouse-Over – Toggle hints to display on mouse-
over.   
 
Design – Select key design style.  
 
Background – Adjust key background settings. 

  Transitions – Adjust floating palette appearance 
settings. (Global, applies to all programs.) 
 

 Restore/Save/Quit: 
Restore Defaults Button – Restore default settings 
for current or all applications.  
 
Save and Close Button – Exits the Settings window 
and returns to the KillerKeys program with settings 
saved.  
 
Save and Quit Button – Exits the KillerKeys program 
entirely with settings saved. 

 Group Settings – Switch to the Group 
Settings window. 

  

   
See the Section 3.8 section for further instruction.   
 

 

Key Size, Mouse-Over, Design, and Background all can be changed according to the specific 
program running. Transitions are global settings and apply to all programs. 
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1.8 Interface Overview: Group Settings 

 
 
 
The Group Settings window allows you to edit, create, and delete shortcut key Groups. 
   

 Group Settings: 
Group Area – Displays the current Groups and 
acts similar to the Master Palette window. 
 
Create New Group – Creates a new shortcut 
Group. 
 
Create New Favorite – Creates a new shortcut 
Favorites Group. 
 
Delete Group – Select a Group to delete from a 
drop-down list of the current Groups. Only empty 
Groups with no shortcut keys can be deleted. 
 
Create Macro – Macro commands automate 
tasks that normally take several steps to 
complete. 

  Key Settings – Switch to the Key Settings 
window. 

   
  . 
   
See the Section 3.8 section for further instruction. 
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2 Interface 

2.1 Master Palette and Floating Palettes 

 
All shortcut keys are stored in the Master 
Palette and organized within Groups. To 
display the contents of a Group, click the 
triangle to the left of the Group name. 

 
 
 
 
 
 
 
 

 
 
 
 

   (Master Palette with all Groups collapsed) 
 

 
To use a shortcut click the key. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                                      (Master Palette with one Group expanded) 
 
 
The number of shortcut keys for the current 
Application, how many are hidden and how 
many are filtered in the Master Palette and the 
Group are displayed in the Status Text. This is 
displayed at the top of the Master Palette, after 
the current Application name, and after every 
Group name. 
 
 
 
 
 

 

 

If the Master Palette window is not wide enough the Status Text may be hidden. 



 

© Bella Corporation 2011, All Rights Reserved                                                       Page 10 
 

 

 
Groups can 
be moved out 
of the Master 
Palette and 
onto the 
screen. Click 
and drag the 
group name, 
then place it 
where you 
would like on-
screen. 
 
 
 

 
This Floating 
Palette can 
be closed 
either by 
clicking and 
dragging back 
into the 
Master 
Palette area, 
or clicking the 
“X” in the 
upper right-
hand corner. 
 
 
 

 

Floating Palettes are useful for keeping your most important shortcuts close at hand. These 
windows are typically smaller than the Master Palette and can stay on-screen even when the 
Master Palette is minimized. Floating Palettes can also be moved anywhere on-screen. 

 
To hide all Floating Palettes and shortcut keys, use the KillerKeys Hide shortcut, which by default is Ctrl + 
Spacebar. The default shortcut can be changed in the Settings Panel. 
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2.2 Favorites Groups 

 
Favorites Groups store commonly used shortcuts. They have certain special characteristics different from 
regular Groups: 
 

 Keys from multiple Groups can be 
placed into the same Favorites Group. 

 Search Results can become a 
Favorites Group by clicking the “Create 
Fav” link. 

  

 If shortcuts are removed from a 
Favorites Group they remain in their 
original Group and can still be used. 

 Shortcut keys in the Master Palette or 
other Floating Palettes can be dragged 
into a Favorites group, even if it is a 
Floating Palette on the Desktop. 

 
 

Click the Star Icon in the top 
right corner of the Master 
Palette to create a new 
Favorites group. 

 
Enter a name for the new 
Favorites Group, then click 
OK.  
 

 
 
 
 
 
 
 
 

 
 
 
Click and drag shortcut keys into the 
Favorites Group. Shortcut keys are 
copied from the original group and are 
not deleted. 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

Every application has a sample Favorites Group that displays some of the most commonly used 
shortcuts for that application. 
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2.3 Shortcut Search 
 

 
The Shortcut Search box 
searches for shortcuts by 
description or keyword 
command. Type the search 
query into the box and hit enter 
or click on the Magnifying Glass. 
The Search Results Group will 
display all shortcuts which 
match the query. 
 

 
 
 
 
 
 

 

 

It's not necessary to type an entire word to find shortcut keys. Typing “Opac” instead of the full 
“Opacity” will still return all opacity shortcuts. The search box searches both short and long 
descriptions, both the text written on the shortcut key and the description that appears when 
mousing-over the button. 

 
 
To search by Keystroke, such as Ctrl or Q, click on the arrow to the 
right of the Search Bar and select Keystroke. 
 
 
 

 

 

It's simple to search for all shortcut keys of the same type. To find all shortcut keys for Opacity in 
Adobe Photoshop type “Opacity” into the Shortcut Search box while Adobe Photoshop is the 
current application. The Search results will display every shortcut for opacity. 
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2.4 Hiding Keys 
 

 
There may be shortcuts you 
already know within the 
KillerKeys shortcut Groups or 
shortcuts which aren't 
necessary to your project. To 
Hide individual keys, click “Edit” 
on the right side of the group 
header.  
 
Click a key to hide it. The key's 
appearance will change to a 
checkerboard background to 
indicate it is hidden. To Unhide 
a key click it again. Click “Done” 
to finish editing. 
 

 

 

Hiding keys in a Favorites Group will remove them from the Favorites Group permanently. Hiding 
a key in a regular Group will also delete the key from any Favorites Groups containing that key.  

 
 

 

Status Text will display the number of hidden keys in a Group or in the Master Palette. 

 
 

 

All Hide settings for shortcut keys and Groups are Profile specific. Switching between Profiles 1, 
2, and 3 can all apply different settings. 

 

 
2.5 Hiding Groups 
 
If there is an entire Group of 
shortcut keys you do not need, 
click the Hide Group icon at the 
top of the Master Palette. 
 
Click “Edit”, and click on a group 
name to hide/unhide it. Click 
“Done” to finish editing. 
 
The Hide Group icon will turn 
Blue to indicate there are one or 
more hidden groups. 
 
 
 



 

© Bella Corporation 2011, All Rights Reserved                                                       Page 14 
 

2.6 Filters 
 
Filters are useful for quickly hiding all shortcut keys of a certain type. Shortcut keys can be filtered by 
Direct keystrokes, keystrokes that use the Ctrl modifier, the Shift modifier, the Alt modifier, or the 
Windows Key modifier. Most applications have commonly used shortcuts activated by a Direct keystroke 
or with the Ctrl key modifier. If you already know these simple shortcuts or do not need them, a Filter can 
hide them from view an make the shortcut keys you do need more accessible.  
 

 

Filtering a modifier key will hide all shortcut keys that use that keystroke, even if they also use 
other modifier keys. Filtering the Ctrl modifier would also hide a keystroke such as “Ctrl + Shift + 
S”. 

 
 
To access the Filter, click the 
Filter Icon at the top of the 
Master Palette. 
 
Click the box next to the 
Modifier Key to filter. By Default 
all keys are selected. Click 
“Apply Filter” to apply and exit 
Filter mode. The Filter Icon will 
turn green to indicate that a 
Filter is applied. 
 
To remove a filter, click the 
Filter Icon again and click on 
“Remove Filter”.  
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2.7 Resizing/Moving/Docking the Master Palette 
 
To resize the Master Palette, click and drag 
the bottom right corner. Click the 
Shrink/Restore icon at the top of the 
Master Palette to shrink the window to its 
smallest possible size or restore it to its 
original size. 
 
 
 
 
 
 
 
 
 

 
Click and drag the Program name to 
move the Master Palette. If the Master 
Palette is clicked and dragged to an 
edge of the screen, the docking key will 
appear. Click the docking key to hide the 
Master Palette window. Clicking the 
docking key again will unhide the Master 
Palette. 
 
 
 
 
 
 

 
Clicking on the Minimize icon at the top of the Master Palette will also hide the Master Palette completely 
from view. Floating Palettes will remain on screen. To restore the Master Palette, click the KillerKeys 
program icon in the notification area. 
 

 

When the Master Palette is hidden, Floating Palettes will remain on-screen. This is useful for 
saving space on your screen. 

 

 

In Windows Vista and Windows 7, a large number of notification area icons will be put into an 
expanded view box. Click on the ‘Customize…’ link in this box to select which icons should 
remain in view at all times, for example KillerKeys. 
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2.8 Profiles 
 
Profiles save specific group arrangements and on-screen shortcuts, allowing different shortcut settings for 
a single application. Many applications have different modes for different tasks. By switching between 
Profiles, new shortcuts can be displayed depending on the current task. Profiles also allow more than one 
user to choose their preferred layout. 
 

 
To create a Profile, click on one of the 
three Profile options at the bottom of the 
Master Palette, and begin arranging keys.  
 
The Profile will be saved in the 
background. To create another profile, click 
on another Profile option key. To rename a 
Profile, double click on the Profile key. 
 
Profiles can be Imported and Exported 
through the File menu under the Settings 
window. There will be two options: “Import 
Profile” and “Export Profile”. 
 

 
“Import Profile” imports a single Profile for the application from which the Profile was exported. When 
importing a Profile you will be given the option to choose which of the three Profiles to overwrite. The 
Profile you choose to overwrite will be erased. 
 
“Export Profile” exports a single Profile for the currently selected application. 
 
If you choose to have the Master Palette hidden or docked, you can also select a profile by right clicking 
on the KillerKeys program icon in the bottom right notification area of your computer. 

 

 

When Exporting a Profile, the version number of your KillerKeys program will be added to the 
name of the file; for example “Word 2010_v1.0.kpf”. Only profile file versions equal to or prior to 
the installed version of KillerKeys can be installed. Profiles that come from a new version of 
KillerKeys than you’re running cannot be installed. Your KillerKeys version number can be found 
in the Settings Window, under the Help menu, by clicking the option “About KillerKeys”. 
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3 Settings 
 
To customize the look of KillerKeys, click 
on the Gear icon at the top of the Master 
Palette or right click the program icon in the 
notification area. 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

The KillerKeys Settings are split into two tabs, Key Settings and Group Settings. On the left is the 
Applications List.  
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3.1 Applications List 
 
The Applications List displays every Application which is 
available to use with KillerKeys. Applications are 
unlocked for use after each license(s) purchase. The 
Master Collection, containing every application, or 
specific Application Editions can also be purchased. 
 

 The Eye icon toggles the KillerKeys shortcuts while in 
specific applications. Locked Applications will appear 
grayed out in the list. By default, every program you have 
access to will have the Eye icon activated. 
 

 To change settings for a 
specific Application, confirm the application is selected 
and highlighted blue in the list then configure the Settings 
to the right. Opening the Settings window while working in 
an application on the list will automatically highlight the 
current application. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Certain applications in the list have both current and previous versions, such as Adobe 
Photoshop CS5 and Photoshop CS4. By default the current version will be selected. Click the 
Eye icon next to the version of the program to be displayed. 
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3.2 Preview Window 
 
  
The Preview Window 
displays an example 
key set and will update 
when changes are 
made to the settings 
below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.3 Key Size 
 
Choose “Two Lines of Text” to display shortcut names on two lines. Choose “Single Line of Text” to 
display shortcut names on one line. Shortcut keys will be smaller and long shortcut names will not be 
completely displayed. “Show Keystroke on Line Two” will display the shortcut name on the top line and 
the keyboard command, such as “Ctrl+S”, on the second line of the shortcut key.  
 

3.4 Mouse-Over (Hover Text) 

 
 
Hover Text appears when 
the mouse cursor stops 
over a shortcut key.  
 
Long Description displays 
the entire shortcut’s 
information upon mouse-
over. The shortcut 
description, keystroke, 
and group name are 
displayed. Keystroke 
displays only the 
keystroke for the selected 
shortcut and Group Name 
displays only the name of 
its group.  
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3.5 Design 
 

 
 
 
“3D Key Effect” is the default selection. “2D Key Effect” changes the appearance of shortcut keys to a flat 
button with a thin outline.  
 
“Drop Shadow” will apply a shadow effect to both 3D and 2D Key Effects. This effect can be edited with 
the “Configure” link. 
 
The “Texture” drop down list changes the appearance of shortcut key backgrounds. 
 
 

3.6 Background 

 
The first slider adjusts the color of Group and Floating Palette backgrounds, from black to grey. The 
“Transparency” slider adjusts Floating Palette background colors from see-through to opaque. “Drop 
Shadow” will apply a shadow effect to Floating Palettes. This effect can be edited with the “Configure” 
link.  
 

 

“Transparency” and “Drop Shadow” will not appear within the Master Palette, only when Groups 
are dragged from the Master Palette to make a Floating Palette. 
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3.7 Transitions (Applied Globally) 
 
This setting adjusts how Floating Palettes appear. “None – Instant” and “Fade In” make Floating Palettes 
appear instantly or fade from transparent, respectively. “Turn In” makes Floating Palettes appear to open 
and expand from a single point. The length of these effects can be adjusted under “Effect Duration”. 
 

 

These settings are applied globally and affect the KillerKeys appearance in every program. 

 
 

3.8 Group Settings 
 
Many of the same adjustments performed in the Master Palette can be performed in the Group Settings 
window. In addition, new Groups can be created, Groups can be deleted, and Macros can be created. 
 
The “Create New Group” button will open a window asking to name the new group. Enter the name and 
click “OK” to add the new group. 
 

 
 

To change the group and shortcut keys color, double-click the color box to the left of the group name.  
 
To delete a Group, first remove all shortcut keys within the Group by clicking and dragging all keys into 
other Groups. Click the “Delete Group” button and choose the Group to be deleted from the drop down 
list. 
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3.9 Creating a Macro 
 
Macro commands automate tasks that normally take several steps to complete.  
 
The “Create Macro” button will open the Macro Settings window.  
 

 
 
To add a keystroke or keystroke combination, click the box to 
the left of the “Add Keystroke” button, press the keystroke on 

your keyboard, and then click the “Add Keystroke” button. 
 
To add a pause, click the box to the left of the “Add Pause(ms)” 
button, type in the number of milliseconds for the macro to 
pause (1000ms = 1 second), and then click the “Add Pause” button.  
 
To remove a keystroke or pause, click on it within the list, and then click the “Remove” button.  
 
“Short Description” will be the description of the macro written on the corresponding shortcut key. “Long 
Description” will appear on mouse-over of the macro shortcut key.   
 

 

If this is the first Macro for the selected application, a new Group called Macros will be created. 
Also, all Macro keys will have an “m” in the upper right corner to denote that it is a macro. 

 
To modify a Macro, click on the Macro in the Group Settings window and the Macro Settings window will 
appear. To delete a Macro, click the blue “Edit” link to the right of the Macros Group name and click the 
shortcut key for the Macro. 
 

 

The “Show Keystroke on Line 2” setting does not apply to Macro shortcut keys. The description 
of the Macro will be displayed. 
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3.10 Licensing Menu 
 

 
 
The Licensing Menu displays information about your KillerKeys license and allows you change your 
licensing options. This menu can be found in the Settings window, under the Help menu.  
 
“Licensed Editions” lists which editions you have purchased for KillerKeys. Purchased editions will have a 
check to the left of their name, while un-purchased editions will be unchecked and unavailable for use. 
Click “Purchase Editions” to be taken to the KillerKeys online store**. 
  
“Updates” displays until what date you will continue to receive updated shortcut key files for your 
KillerKeys purchased editions. If Updates are valid, you may also install any newer versions of the 
KillerKeys application free of charge. To renew and purchase further updates, click the “Renew Updates” 
key**. 
 
The “Refresh” button will look to the KillerKeys server to present you with the most up to date licensing 
information. A refresh command is sent automatically each time you start KillerKeys. If you recently 
purchased a new Edition and it hasn’t yet displayed under the Licensed Editions section, running a 
Refresh will update that for you and unlock the proper application shortcuts**.  
 
The “De-Authorize This Computer” button will remove your KillerKeys license from the current computer 
and allow you to install KillerKeys with your current license on another computer**. To Re-Authorize a 
computer that has previously been De-Authorized, please refer to the Advanced Licensing section (3.14). 
 
**(Internet Connection Required) 
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3.11 File Menu 
 
“Restore All Defaults” restores the default KillerKeys settings for every application in the list. ”Restore 
Application Defaults” will restore the default settings for only the Application currently selected. 
 
“Import Profile” imports a single Profile for the application from which the Profile was exported. When 
importing a Profile you will be given the option to choose which of the three Profiles to overwrite. The 
Profile you choose to overwrite will be erased. 
 
“Export Profile” exports a single Profile for the currently selected application. 
 
“Import Application” imports all 3 Profiles for the currently selected application. “Export Application” 
exports all 3 Profiles for the currently selected application. 
 
“Quit” exits the KillerKeys program completely. 
 
 

3.12 Help Menu 
 
“User Guide” opens the KillerKeys User Guide, this document. 
 
“Video Tutorials” opens the KillerKeys Video Tutorials page on the KillerKeys website. 
 
“Support” opens the KillerKeys Support page on the KillerKeys website. The Support page contains 
various links to any support related question/concern you might have. 
 
“Licensing” opens the Licensing Menu, as is described in section 3.10 of this User Guide.  
 
“Check for Updates” lets you know if there is a newer version of the KillerKeys program than you are 
currently running. This check automatically happens during each startup of the program as well. If you are 
unable to download and install the latest updates, you may need to renew your yearly Updates on the 
KillerKeys store. 
 
“About KillerKeys” displays basic program information, the program version and copyright info. 
 
“Provide Feedback” opens a feedback form for KillerKeys. Here you can contact Bella Corporation with 
your suggestions, comments or requests. 
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3.13 Exiting the Program 
 
“Save and Close” saves all changes and closes the KillerKeys Settings window but does not close the 
KillerKeys application. 
 

 
 

“Save and Quit” saves all changes and closes the KillerKeys application completely. The “Quit” selection 
under the File menu performs the same action.  
 
Clicking the red “X” at the top of the window displays the option to either close the settings window or 
close the KillerKeys application completely. 
 
Outside of the Settings window, right-clicking the KillerKeys program icon in the bottom right corner of 
your screen will display a number of options, including closing the KillerKeys program completely. 
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3.14 Advanced Licensing 
 
Certain licensing features are available via a special launch method of the KillerKeys application. If 
KillerKeys is already running, please quit the program before attempting this method. 
 
Start by selecting your KillerKeys.exe from within your Program Files folder. Next, hold down both the 
Shift Key and the Windows (OS) Key simultaneously, and then proceed to launch the KillerKeys.exe 
application by double-clicking it. Continue holding the Shift+OS Key until startup is finished, you should 
notice that a new Licensing Options window is presented to you. 
 

 
 
The License Options window will have several tabs that you can cycle through via the arrows on the top 
right, they include: 
 
Remote Reset 
Release License 
Restore License 
Refresh Features 
Feature Passwords 
Activation Data 
Block License 
 
Unless otherwise instructed by a Bella Corporation employee, the only tab you should focus on would be 
the Restore License option.  
 
In the event that you’ve De-Authorized your computer, this is the only method in which you’re able to Re-
Authorize it, by way of the Restore License tab. 
 
Once you’re on the Restore License tab, you’ll see some text, as well as a couple buttons below. Click 
the “OK” button to restore your license to that computer. Once you restore the license, it will no longer be 
available to use on a different system. Also, you cannot restore a license if you’ve already activated that 
license on a different system. 
 
CAUTION: Clicking on any of the options from the other tabs may permanently lock the KillerKeys 
application from running on your computer. Never click on any other options in the License Options 
window without verbal or written instruction from Bella Corporation. 
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4 KillerKeys Express iPad App 
 

I. Getting Started 

 
KillerKeys Express is an iPad App that controls your computer using a WiFi connection. The iPad App 
displays shortcuts for the application you are working in on a virtual (VR) keyboard on the iPad, and 
includes a track pad, widgets, Quick Launch and Active App switching for complete control of your 
computer. 
 

 
 
 

Connecting your iPad to KillerKeys 

After installing the KillerKeys software and entering the licensing information on your computer, follow 

these steps to connect your iPad to your computer. 

1) The connection from the iPad to your computer uses WiFi: make sure the Wifi signal that you are 

connecting to is on the same network as the computer you have installed the KillerKeys software. 

2) You will need to know the IP of the computer that KillerKeys is installed on and enter it on the iPad. 

You can find the IP from the KillerKeys desktop application by doing the following: 

a) Find the KillerKeys Express or Pro icon in the notifications area. 

b) Right-click on the icon and select “Launch KillerKeys Pro Settings” or " “Launch KillerKeys Express 

Settings.”  

c) Under Global Settings, click the radio button for Tablet Mode 

d) Select the Tablet tab, where you will find the IP for your computer. 

e) Enter the IP on the iPad and press “Connect” 

f) Select “Save and Close” on the KillerKeys desktop application. 

g) After the initial sync on the iPad, you should be good to go. 
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II. The Interface: Overview 

 
1. Number of Shortcuts 

Shows you how many shortcuts are available for the application you are in. 

 

2. Active Application 

This is the name of the active application on your desktop. 

 

3. The VR Keyboard in Standard (non-VR) mode 

This keyboard has the keys of a standard computer keyboard, giving you access to keys such as 

F keys, Home and End, Page Up and Down etc. 

 

4. Settings Button 

Click the Settings button to access the Quick Launch menu options. 

 

5. Active Apps 

The Active Apps side bar area shows you the icons of any applications that are currently running 

on your desktop. To switch from one application to the next, press the icon of the application. 
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6. Multimedia Widget 

The multimedia widget provides a number of features depending on the application that you are 

in. See the Multimedia Widget section for more details. 

 

7. VR Mode Button 

The VR Mode button toggles the VR mode of the keyboard on and off. In this view the VR mode 

is off (the key is gray); once VR mode is activated, the button will turn green. 

 

8. Left-Click Button 

The left-click button performs a mouse left click when using the trackpad. 

 

9. Trackpad 

The trackpad provides mouse control over your computer and supports pinch-to-zoom 

(application dependent). 

 

10. Right-Click Button 

The right-click button performs a mouse right click when using the trackpad. 

 

11. Scroll Area 

Moving your finger up and down the scroll area will scroll documents or web pages accordingly. 

 

12. Volume Control 

The volume control allows you to control the system volume. 

 

13. Zoom Control 

The zoom control allows you to easily zoom in and out of web pages and other supported 

documents. 

 

14. Quick Launch 

You can drag applications that you use most frequently into the Quick Launch side bar. See the 

Quick Launch section for more details. 
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III. The Interface: VR Mode 

 
When KillerKeys Express is in VR mode, shortcuts for the application you are in will be 
displayed on the keyboard; you must have a recognized application running and in the 
foreground (the active application) for the shortcuts to be displayed. If an application is not 
recognized, “No Application” will be displayed in place of the application name. 
 
 

 
1. Modifier Locked 

You can lock down a modifier key, such as the Control or Command key. This can be useful for 

applications such as Microsoft Word or Excel that have few direct keystrokes but many Control or 

Command keystrokes. When the modifier is locked, the key turns dark gray and the lock symbol 

is closed. To lock or un-lock a modifier key, press the lock symbol. 

 

2. Modifier Un-Locked 

This is an example of an un-locked modifier key. 

 

3. Shortcut Name 

When the keyboard is in VR mode, the top portion of the key will display the shortcut name and 

the key will be colored according to the group of shortcuts that it is associated with. 

 

4. Key ID 

The bottom portion of a key shows the key that is normally displayed on the keyboard. 
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5. VR Mode - Active 

The VR Mode button toggles the VR mode of the keyboard on and off. In this view the VR mode 

is on (the key is green); once VR mode is turned off, the button will turn gray. 

 

6. Multiple Shortcut Notification 

Many applications assign more than one shortcut 

to the same key (or key combination), so the 

meaning of the shortcut changes based upon 

which mode of the application you are in. For 

example, in Premiere Pro, the "O" key has both 

"Mark Out" and "Rotate" assigned to it. Keys that 

have multiple shortcuts assigned have a dotted 

separation bar (rather than solid). To switch the 

name on the key to what you use most, simply 

press and hold the key and a selector window will appear. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

© Bella Corporation 2011, All Rights Reserved                                                       Page 32 
 

IV. Multimedia Controller 

 

The multimedia controller will activate various buttons depending on the application you are 
working in. Below are a list of the buttons and common functions that are mapped to them. 
 
 
1. Set or Mark In 

Used for most audio and video applications to mark the In point of a media clip. 

 

2. Set or Mark Out 

Used for most audio and video applications to mark the Out point of a media clip. 

 

3. Clear Mark In 

Used for most audio and video applications to clear the In point of a media clip. 

 

4. Clear Mark Out 

Used for most audio and video applications to clear the Out point of a media clip. 

 

5. Jog Wheel 

Spin the wheel left or right to move backwards or forwards : in audio and video applications, you 

will move frame by frame through the media; in many documents, you will move character by 

character. 

 

6. Previous Point or Section 

This will jump you to the previous point or section; in word processing documents, it will move you 

to the previous word. 
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7. Next Point or Section 

This will jump you to the next point or section; in word processing documents, it will move you to 

the next word. 

 

8. Reverse Play 

For many audio and video applications, this will play the media in reverse, with each successive 

press increasing the speed. 

 

9. Stop or Pause 

For many audio and video applications, this will stop playback of the media. 

 

10. Forward Play 

For many audio and video applications, this will play the media forward, with each successive 

press increasing the speed. 
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V. Quick Launch Menu 

 
Access the Quick Launch menu by pressing the gear setting icon on the upper 
right corner of the iPad. Once you press the setting button, KillerKeys will 
scan your computer for installed applications and display them in the All 
Applications column. 
 

1. All Applications 

This is a list of the applications installed on your computer. If an application is missing, 

launch the application and press Refresh and it should show up. If it still doesn’t show 

up, close the Quick Launch window and re-open it by pressing the Settings button. 

 

2. Quick Launch Applications 

To add applications to the Quick Launch side bar, press and hold the application on the 

All Applications list until it turns blue, then drag the application to the Quick Launch 

Applications column. To remove items from the Quick Launch Applications list, swipe 

right on the application name and a “Delete” button will appear. 
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5 Additional Information 
 

1. Shortcut keys are derived from their respective programs’ default shortcuts. If you have changed 
the default shortcuts in your program some of the KillerKeys shortcuts may not function properly.  

 
 Example: By default in Premiere Pro “J” is the shortcut for Rewind. If you have changed the 
 shortcut for Rewind to “R”, the KillerKeys shortcut for Rewind will not function. KillerKeys is  
 sending the default “J” command. 
 

2. Some shortcut keys are mode specific and will not work in every area of the target program.  
 
 Example: “O” is the shortcut for Mark Out in the Timeline area of most editing applications. 
 However if your focus is on the Bin area, not the Timeline, clicking the KillerKeys shortcut for 
 Mark Out will not function. 
 

3. Some KillerKeys shortcut keys may appear to be duplicates. Some programs have multiple 
keyboard shortcuts for the same action. If the “Show Keystroke on Line Two” setting in the 
KillerKeys Setting window is enabled these shortcut keys will display the same description but 
different keystrokes. 

 
 Example: In Internet Explorer the shortcut keystroke for “Close Tab” is both Control+W and 
 Control+F4. 
 

4. Some shortcuts may not function or be missing in the KillerKeys database. KillerKeys shortcuts 
are created from the programs themselves and as such discrepancies in the shortcuts displayed 
in a program, and the shortcuts which actually exist, can affect KillerKeys shortcut keys. If you 
notice missing or non-working shortcuts please contact Bella Corporation so the shortcut keys 
can be adjusted in future updates. 
 

5.1 Obtaining Technical Support 

 
We are confident that our product will provide you with many years of trouble free service, however 
should you need assistance, we have provided you with a number of resources. 
 
The support section of our web site ( www.KillerKeys.com/support ) is the best source for the latest 
information and support on all our products. Please check the KillerKeys FAQs and Video Tutorials prior 
to contacting us for technical support, as this will provide you with immediate answers to the most 
common issues or concerns. On our site you will also find: 
 

Software Updates 
Settings Files 

Instructional Videos 
FAQs (Frequently Asked Questions) 

Latest Product Information 
 
 

www.KillerKeys.com 
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